
Lesson 3: Where do grids come from? 
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In this lesson, you will learn:  

• how ArcView Spatial Analyst manages grid themes  
• how to use the Source Manager  
• how to convert themes to grids  
• how to create grids from various raster import formats  
• how to export grids  
• how to obtain data for use in ArcView Spatial Analyst  

TOPIC1: Managing grid themes 
 

Grid datasets are stored in a workspace directory and use INFO format files. Because the INFO 
file format is used to store grid theme data, you should be careful when copying, deleting, and 
renaming grids.  

In this topic, you will learn about the grid data model and grid data structure and how grid 
datasets are stored in a workspace. You will also learn about the Source Manager, which should 
be used to manage grid datasets instead of operating system file managers 

Concept 
 
Workspaces 
 

A workspace is a directory that contains geographic datasets like ArcInfo coverages or grid 
datasets. A workspace contains one info subdirectory and a subdirectory for each grid. Grid 
subdirectories contain several files that store geographic location and attribute data. The info 
subdirectories contain several files that relate to each grid's theme table.  

 
Grids are stored in a workspace directory. A 
workspace contains one info subdirectory. Each grid 
is a subdirectory. 

ArcInfo grids and coverages are stored in workspaces. If you create a grid and do not already 
have a workspace to store it, ArcView GIS will create the workspace directory for you. It will make 
the info subdirectory and create a grid subdirectory with all its corresponding data files. Copying 
workspaces with operating system commands is permissible, as long as you use a recursive copy 
command (e.g., DOS xcopy with the /s option or UNIX cp with the -r option).  



Grid datasets are stored as a directory of several files that have related or corresponding data 
files in the info subdirectory. Therefore, deleting a grid directory with an operating system 
command does not remove all of that grid's data files. Use the Source Manager (discussed later 
in this section) to delete grid directories.  

The info subdirectory contains data files about each grid. ArcView creates, reads, and edits info 
subdirectories and corresponding data files 

Concept 
 
Grid directory structure 
 

Grid subdirectories store data files about each grid. Some grid data files have related INFO files 
and some do not. If a grid is altered, ArcView Spatial Analyst automatically updates the 
corresponding information in these files.  

Only integer grids have a grid theme table, vat.adf, to store unique cell values and a cell count for 
each value.  

 
Grid subdirectories contain data files about each grid. 
Some files are in INFO format, while others are 
ASCII format and binary format. 

The boundary file, dblbnd.adf, contains the minimum and maximum x,y coordinates of the grid 
theme. The boundary is a rectangle that surrounds all cells in a grid.  

The statistics about cell values, including the minimum, maximum, mean, and standard deviation, 
are stored in the sta.adf file. You can see these statistics for any theme by clicking the Statistics 
button inside the Legend Editor.  

The log file is an ASCII file containing a history of the grid dataset from its creation through any 
alterations that have been performed on it. Log files store the type of operation and the time and 
date it was performed.  

The projection file (prj.adf) is an optional ASCII text file used to store known map projection 
information. The projection file is typically present in grids from ArcInfo and is created if the grid 
was imported from a DEM or projected. ArcView GIS does not create a projection file. The 
projection file, if present, provides the projection parameters you will need to set the projection of 
a view.  



The data in a grid theme is tiled and stored in binary row and column tile files. The w001001.adf 
file stores the first tile. If more tiles are needed, the second tile is named w001002.adf. The 
corresponding X files are an index to the tile file.  

The header file (hdr.adf) is a binary file containing the grid's cell resolution, type (integer or 
floating point), compression, blocking factor, and tile information 

Concept 
 
Grid data structure 
 

The format of grid datasets is based on a hierarchical tile block structure. A tile is a variable 
length file capable of handling grids as large as 4,000,000 by 4,000,000 cells. Larger grids are 
automatically divided into multiple tiles. A tile is divided into blocks, which are stored as variable 
length records. The tile block structure allows sequential and random access to data. The size 
limit for a grid is a function of the tile naming convention; there can be as many as 999 by 999 
tiles, each with up to 4,000,000 by 4,000,000 cells. 

 
Grids are stored as a series of blocks with data 
compressed within each block. There's no need to 
worry about how blocks are created and used in a 
grid dataset; ArcView Spatial Analyst manages this 
for you. What you see and use is a single grid 
dataset, not a number of adjacent grids that must be 
managed individually. Thus, grid data management 
is transparent. 

There are more blocks on the y-axis than on the x-axis; therefore, a block is not a square, but a 
rectangle that is wider than it is tall. (A rectangular structure is used to increase efficiency of 
certain operations that examine the grid on a row-by-row basis. It also aids in integer data 
compression.) A block is made up of cells arranged in a Cartesian matrix consisting of rows and 
columns. Cells inside the block are always square.  



The tile, block, and row-column hierarchical divisions form the spatial indexing for grid datasets. 
Spatial indexing allows for fast data retrieval regardless of the grid's size.  

Grid data is accessible seamlessly. In the rare event that more than one tile is needed for data 
storage, ArcView Spatial Analyst automatically keeps track of the tile and block positions through 
spatial indexing. Spatial Analyst optimizes tile and block sizes automatically, a process that is 
totally transparent to the user.  

Integer grids are compressed using a run-length compression scheme within each block 
("adaptive run-length encoding"). When adjacent cells have the same value, runs are created and 
the data can be compressed. Floating point grids are never compressed because there may be a 
unique value for every cell.  

The location and size of all grid cells are stored in double precision (8-byte) floating point 
numbers. The values of floating point grids are stored as 4-byte floating point numbers (single 
precision). The values of integer grids are 4-byte integers (long integers). 

Concept 
 
The info subdirectory 
 

Some grid data files, like the VAT, have related INFO files called the nit and dat pairs. These files 
have filename extensions nit and dat.  

The vat.adf, sta.adf, and dblbnd.adf files in a grid subdirectory have corresponding INFO files, the 
nit and dat pairs, in the info subdirectory. The info subdirectory also contains a data dictionary file 
called arc.dir. ArcView knows how to read and edit INFO format files. Do not try to edit the INFO 
files with the operating system.  

Grid INFO format files have a pair of related INFO files. The grid file (e.g., vat.adf) contains raw 
data values. Its corresponding INFO nit (e.g., arc0001.nit) file contains file structure and field 
definition information. The INFO dat (e.g., arc0001.dat) file contains a relative path to the grid 
data file (e.g., ../soils/vat.adf).  

Also present in the info subdirectory is the INFO directory file, arc.dir. It contains a list of all the 
INFO files in the database.  



 
The info subdirectory has one nit and data pair per 
related grid data file (e.g., vat.adf). The vat.adf file 
is the value attribute table (VAT) for the soils grid 
theme. 

 
Exercise 
 
Examine the grid data structure 
 
The objective of this exercise is to learn how grid 
datasets are stored. You will examine a workspace 
and become familiar with the files associated with a 
grid. 

  

  
 
If you have not downloaded the 
exercise data for this module, you 
should download the data now. 

     
 

Step 1  
 
Start ArcView 

  

Start ArcView and load the Spatial Analyst extension.  

Note: If you are running ArcView GIS 3.1, you see a Welcome to ArcView GIS dialog. 
Click Cancel to close this dialog. 

If ArcView is already running, close any open projects. 

  

 
Step 2  

 
Open the project  



  

From the File menu, choose Open Project. Navigate to the gridsa\lesson3 folder and 
open the project l3_ex01.apr. 

Note: If you are running ArcView GIS 3.1, you see an Update l3_ex01.apr message 
box. Click No to dismiss this box. 

When the project opens, you see a Mt. St. Helens view containing a Mt. St. Helens 
theme. 

  

 
Step 3  

 
Examine a workspace  

  

In this step, you will examine the workspace associated with this lesson. 

The gridsa\lesson3 directory is a workspace that can store grids. If you try to create a 
grid dataset in a directory that is not a workspace, ArcView Spatial Analyst converts 
the directory into a workspace. It adds the info subdirectory and the corresponding 
grid data files. 

Using operating system commands or a file manager, navigate to your 
gridsa\lesson3 folder and view the contents. 

Workspaces always have one info subdirectory as well as one subdirectory for each 
grid. 

 

 

  

 
Step 4  

 
Examine a grid directory  

  

Next, take a look at a grid directory. 

Now change directories to the helengrd grid directory and examine the contents. 

Notice that Helengrd is an integer grid as it contains a VAT file (vat.adf), contains one 
tile and its corresponding index (w001001.adf and w001001x.adf), has a header file 
(hdr.adf), and contains a log file (log.adf). 

 

  

 
Step 5  

 
Examine a grid log file  

  

Each grid directory contains a log file that tracks the procedures performed on the 
grid. Log files are ASCII text files and can be examined with a text editor or displayed 
in a script editor window. You will look at the log file for the Helengrd theme. It 
contains a list of procedures applied to the grid with the date, time, and user 
information for each. 

In the L3ex01.apr project window, open the empty script Helengrd Log File.  

Load the log file from the helengrd directory into the script editor window by clicking 

the Load Text File button . 

  



In the file browser, navigate to the gridsa\lesson3\helengrd directory.  

Change the List Files of Type dropdown list to Text file. Double-click the Log file to 
load it into the script editor window. 

Examine the log file. Any procedures performed on helengrd will be listed in the log 
file in uppercase letters. 

Close the Helengrd Log File script. 
 

Step 6  
 
Finish the exercise  

  You have completed this exercise. If you like, go on to the Challenge  
 

Challenge 
Examine a grid data structure  

In this exercise, you examined a workspace and became familiar with the files associated 
with a grid.  

Using operating system commands or a file manager, move to the gridsa\lesson3 
directory and answer the following questions:  

1. How many grids are in this workspace?  
2. How many files are in the info directory?  
3. In the info directory, how many pairs of nit and dat files are there?  

Now change directories to the elev grid directory and answer the following questions:  

4. Is elev an integer or floating point grid?  
5. Which file indicates an integer grid?  
6. Does elev have a projection file?  

Use the prj file for elev to answer the following questions:  

7. What projection is elev?  
8. Which datum is used?  
9. What units are used? 

Solution to challenge  

In the workspace:  

1. There are 5 grids.  
2. There are 33 files in the info directory.  
3. There are 14 pairs of nit and dat files in the info directory. 

In the elev grid directory:  

4. Elev is an integer grid.  
5. A vat.adf file indicates an integer grid.  
6. Elev has a projection (prj) file.  



The prj file:  

7. The prj.adf file is an ASCII file so it may be read with a text editor. Elev is in the 
UTM projection.  

8. Elev uses the NAD83 datum.  
9. Elev uses meters as units 

TOPIC2: The Source Manager 
 

You use the Source Manager to copy, delete, and rename grid datasets. The Source Manager 
handles files in the grid subdirectory and the associated files in the info subdirectory. 

 
To manage data sources, choose Manage Data 
Sources from the File menu. The Source Manager 
allows you to manage either shapefile or grid data 
sources. You can copy, rename, or delete these data 
sources simply by browsing. [Click to enlarge] 

Do not use operating system commands to move, copy, or delete grid datasets because each 
grid dataset stores some of its files in the info directory. You should only rename, copy, or delete 
grid datasets using the Source Manager.  

Using operating system functions to perform these actions will not work because the operating 
system does not understand the relationship of the info subdirectory and all its related files.  

Workspace directories, however, can be moved, copied, or deleted with operating system 
commands. Workspace directories contain the info subdirectory and any grid data set 
subdirectories.  

You can also use the Source Manager to copy, delete, and rename shapefiles 



Concept 
 
Grid theme properties 
 

Similar to feature themes, grid themes have a name and source location. Grid theme properties 
also include the following: cell size, number of rows and columns, grid extent, type, and status. 
Changing the grid theme name does not change the grid dataset's source name. To change the 
source name, use the Source Manager.  

To access grid theme properties, choose Properties from the Theme menu. 

 
Grid theme properties include source directory, cell 
size, rows and columns, extent of grid, grid type, 
and permanent or temporary status 

Concept 
 
Temporary grids 
 

Grids created as a result of performing analysis are stored as temporary datasets in the project's 
working directory. They are deleted when the corresponding theme is deleted from a view, when 
the project is quit without saving, or on exiting ArcView without saving.  

The grid datasets become permanent when the project is saved or if the Save Data Set option is 
chosen from the Theme menu. Once a grid dataset is permanent, you can use the Source 
Manager to copy, delete, or rename it. 

 
Temporary grids result from spatial analysis and map 
queries. They are created in the project's working 
directory. [Click to enlarge] 

It is important to know your working directory. As you perform analysis functions, many temporary 
grids may be created. The more temporary grids you create, the greater the risk of filling up your 
computer's storage space. Remember to manage your working directory.  



You can set the working directory in the Project Properties dialog. If you don't set the working 
directory, it is automatically set to your home directory or to the temp directory if no home 
directory is defined. 

Exercise 
 
Compare permanent and temporary grids 
 
When using Spatial Analyst for map queries, temporary grids 
are created to store the results of the query. In this exercise, 
you will make a map query, examine the resulting grid theme 
and its temporary dataset, then save the grid permanently. 

  

  

 
If you have not downloaded the 
exercise data for this module, 
you should download the data 
now. 

     
 

Step 1  
 
Start ArcView 

  

Start ArcView and load the Spatial Analyst extension. Note: If you are running 
ArcView GIS 3.1, you see a Welcome to ArcView GIS dialog. Click Cancel to close 
this dialog. 

If ArcView is already running, close any open projects. 

  

 
Step 2  

 
Open a project  

  

From the File menu, choose Open Project. Navigate to the gridsa\lesson3 directory 
and open the project l3_ex02.apr. 

Note: If you are running ArcView GIS 3.1, you see an Update l3_ex02.apr message 
box. Click No to dismiss this box. 

When the project opens, you see a Mt. St. Helens view containing a Mt. St. Helens 
theme. 

  

 
Step 3  

 
Create a working directory  

  Using your operating system, navigate to the gridsa\lesson3 directory and create a 
subdirectory named work.   

 
Step 4  

 
Use Map Query  

  

In this step, you'll build a map query on the Helengrd theme to find areas with 
elevations greater than 2000 meters. 

Make the Helengrd theme active. From the Analysis menu, choose Map Query. In the 
Map Query 1 dialog, build the query shown below: 

( [Helengrd] > 2000 )  

  



Click Evaluate. 

When the new theme is created, close the Map Query 1 dialog. 

Notice the new theme, Map Query 1. It has values of 0 and 1. Areas with a value of 1 
are above 2000 meters.  

Turn off the Helengrd theme. Turn on the Map Query 1 theme and make it active.  
 

Step 5  
 
Examine theme properties for a temporary grid  

  

From the Theme menu, choose Properties.  

In the Theme Properties dialog, notice that the status of the new grid data source is 
temporary. You'll probably also notice that the source is listed as your temp directory. 
The name associated with the grid dataset is Map Query 1. After you are familiar with 
the properties of this temporary grid, click Cancel to close the Theme Properties 
dialog. 

 

  

 
Step 6  

 
Save Map Query 1 as a permanent grid  

  

Now you will save Map Query 1 as a permanent dataset.  

From the Theme menu, choose Save Data Set.  

In the Save Data Set dialog, navigate to the gridsa\lesson3\work directory and name 
the output grid heln2000.  

From the Theme menu, choose Properties and change the name of the theme to 
Helen 2000.  

Notice that the status is now permanent and the grid dataset is stored in the work 
directory as heln2000. 

Click OK. Close the project without saving any changes. 

You have completed this exercise 

 

 
Exercise 
 
Manage grids 
 
The objective of this exercise is to learn how to use 
the Source Manager to copy, rename, and delete 
grid datasets from a workspace. 

  

  
 
If you have not downloaded the exercise 
data for this module, you should download 
the data now. 

     



 
Step 1  

 
Start ArcView 

  

Start ArcView and load the Spatial Analyst extension.  

Note: If you are running ArcView GIS 3.1, you see a Welcome to ArcView GIS dialog. 
Click Cancel to close this dialog. 

If ArcView is already running, close any open projects. 

  

 
Step 2  

 
Open a project  

  

From the File menu, choose Open Project. Navigate to the gridsa\lesson3 directory 
and open the project l3_ex03.apr. 

Note: If you are running ArcView GIS 3.1, you see an Update l3_ex03.apr message 
box. Click No to dismiss this box. 

When the project opens, you see an empty Mt. St. Helens view. 

  

 
Step 3  

 
Use the Source Manager  

  

First, you will copy grids of Mt. St. Helens before and after the eruption.  

From the File menu, choose Manage Data Sources. 

In the file browser, move to the gridsa\lesson3 directory and change Source Types 
to grid.  

Select the grid hbefore and click Copy. 

Next, you are prompted for a directory location and name for the new grid dataset.  

Navigate to the gridsa\lesson3\work directory and name the new grid Before. Click 
OK.  

The new Before grid is copied into the work directory and the Source Manager returns 
to the original directory. 

Repeat this procedure for hafter. Name the new grid After. 

Click Cancel to close the Source Manager. 

  

 
Step 4  

 
Add themes  

  

Click the Add Theme button.  

Navigate to the gridsa\lesson3\work directory and select the Before grid. 

Click OK to add the Before grid to the Mt. St. Helens view. 

Turn on the Before grid theme and notice that the eruption has not taken place yet. 

  



Now add the After grid theme using the same procedure. This grid represents Mt. St. 
Helens after the eruption. 

 
Step 5  

 
Compare themes using Map Calculator   

  

Now you will subtract the Before and After Mt. St. Helens grids. 

From the Analysis menu, choose Map Calculator.  

In the Map Calculator, enter the following expression: 

( [Before] - [After] ) 

Click Evaluate and close the Map Calculator. 

Turn on the new theme Map Calculation 1 and make it active. Turn off all other 
themes. 

 

The positive elevations represent areas that are gone now and the negative 
elevations represent deposits of rock, soil, and ash from the eruption.  

Choose Properties from the Theme menu. Notice the grid is a temporary grid. 

In the next step, you will permanently save the dataset. 

 

  

 
Step 6  

 
Save a temporary grid to permanent  

  
From the Theme menu, choose Save Data Set.  

Name the grid eruptdif and save it in the gridsa\lesson3\work directory. 
  

 
Step 7  

 
Clean up the project  

  

Finish this exercise by cleaning up the project. 

Make all the themes active, then from the Edit menu, choose Delete Themes to delete 
all the themes.  

Next, you will remove the Before and After grid datasets, keeping only the eruptdif 
grid. 

From the File menu, choose Manage Data Sources.  

In the Source Manager, navigate to the work directory and click on Before, then click 
Delete. Repeat this procedure for the After grid dataset. 

Click Cancel to close the Source Manager. Close the Mt. St. Helens view. 

  

 
Step 8  

 
Close the project  



  
Close the project without saving any changes.  

You have completed this exercise 
 

 
TOPIC3: Converting grids 
 

ArcView Spatial Analyst can convert a variety of data to the ARC GRID format. This data includes 
both feature and image themes. ArcView Spatial Analyst also allows for several standard raster 
file formats to be converted to grids.  

Grids may also be converted to other formats. Integer grids can be converted to polygon themes. 
ArcView Spatial Analyst can also export grids to two standard raster file formats. 

Concept 
 
Grid data sources 
 

ArcView Spatial Analyst can use data in many different formats. Some datasets may be 
converted or imported to grids. Spatial Analyst also has two export formats to output grids.  

 
ArcView GIS can convert data to and from many 
formats. 

Concept 
 
Converting themes to grids 
 

Themes, including feature and image themes, can be converted to grids. This vector to raster 
conversion (rasterization) changes the point, line, and polygon features that are stored as lists of 
x,y coordinates into cells that have a value and the same x,y location.  

Any feature theme can be converted to a grid, including themes that have shapefile, ArcInfo 
coverage, or CAD drawing data sources. 



 
ArcView Spatial Analyst can convert both feature and 
image themes into grids. This process is called 
rasterization. The left part of the diagram represents 
a polygon feature theme. The right part of the 
diagram is its representation as a grid theme. 

Several image formats may also be converted to grids. Why convert an image to a grid? You may 
want to convert an image to a grid to use some ArcView Spatial Analyst functionality, such as 
Warp to register an image.  

An image that is typically produced by a remote sensing device, such as a camera or an 
electronic scanner. Examples of images include photographs taken from satellites and aircraft. An 
image is stored in a raster file with a header that contains important information such as the 
number of rows and columns in the image, the number of bits per pixel, and georeferencing data.  

Images can have one or more bands, each representing the energy response in a defined portion 
of the electromagnetic spectrum. These bands can be displayed with different colors (normally 
red, green, and blue). Single band images are often displayed using a gray scale.  

Image conversion formats include:  

• ERDAS®  
• IMAGINE® (if the Images extension is loaded)  
• RLC (run-length compressed files)  
• BIL, BIP, BSQ  
• Sun® Rasterfile  
• TIFF  
• JPEG (if the Images extension is loaded)  
• BMP (Windows™ bitmap images) 

Concept 
 
Converting grids to polygon shapes 
 

Integer grid themes can be converted to polygon feature themes.  

ArcView Spatial Analyst creates a polygon shapefile from the cell value information in an integer 
grid. Polygons are created from groups of contiguous cells having the same cell values. Polygon 
boundaries are formed by the cell boundaries of a grid. Coordinates for the shapefiles are 
determined by the grid's boundary file information and cell size.  

The generalization algorithm maintains the integrity of the data. If you convert grids to a polygon 
theme and then convert the polygon theme right back to grids, the two grids will match up with the 
same cell values. The beginning grid and the ending grid would be the same.  



During the basic raster to polygon (vectorization) conversion, the lines for polygons are formed 
from the grid cell regions. The polygon line will never cross cell centers of bordering cells. 

 
Only integer grids can be converted to polygon 
themes. At left you see a representation of a grid 
theme. At right is its representation after its 
conversion to a feature theme. 

Using the AsPolygonFTab Avenue request, you can specify a second algorithm that makes the 
polygons with the stair-step effect. Polygon boundaries are created from the cell outlines. No 
smoothing, weeding, or generalization takes place 
 
Concept 
 
Import formats 
 

Several standard file formats can be imported to create grids. The import process creates a grid 
dataset from the import file and asks whether you want to add the grid as a theme to your view. 

 
With a view active, ASCII, Binary, USGS DEM, and US DMA DTED data 
may be imported by selecting Import Data Source from the File menu. 

ArcView Spatial Analyst can import ASCII and binary format files to create grid datasets. This 
allows the transfer from other cell-based systems.  

Digital elevation model (DEM) files in USGS format can be converted into grids. The input DEM 
file can be any standard USGS 7.5 minute, 1-degree, or any other file in USGS DEM format.  

The USGS has digital terrain data for most regions in the United States. For more information, 
contact the USGS at National Cartographic Information Center, 507 National Center, Reston, VA 
22092. The corresponding WWW site is at http://nsdi.usgs.gov/nsdi/.  



US DMA (Defense Mapping Agency, now the National Imagery and Mapping Agency) Digital 
Terrain Elevation Data files can be converted to grids. Refer to military specification MIL-D-89020 
for more information. The URL for the NIMA Web site is http://www.nima.mil 

Concept 
 
Export formats 
 

Grid themes can be exported to ASCII or binary raster files. This is useful for transfer or 
exchange of data with other cell-based or raster software systems that do not support the ESRI 
grid dataset. These export files make exchanging data across networks simple and quick. 

 
With a view active, grid themes may be exported to ASCII or binary 
raster files by selecting Export Data Source from the File menu. 

The ASCII raster file contains a few lines of header data followed by lists of cell values. The 
header data includes the following: number of rows and columns, origin, cell size, and No Data 
value information.  

The binary export creates two files: a floating point binary file and a supporting ASCII header file. 
The header file has an .hdr file extension and includes the following: number of rows and 
columns, origin, cell size, No Data value information, and the byte order of the binary values. If 
the grid dataset contains projection information, it will be stored in a third file that has .prj file 
extension. 

Concept 
 
Getting data 
 

The purpose of the ArcData Publishing Program is to make high-quality data accessible to ESRI 
software users.  

Geographic data from over 40 leading commercial data publishers offers you an unsurpassed 
collection of data, including business demographics, political geographies, satellite imagery, 
postal geocodes and boundaries, and environmental data. For example, available business data 
includes address, franchise, census, lifestyle, employment, transportation, crime, and other data.  



ArcData is delivered in formats that are directly usable with ArcView, ArcCAD, PC ARC/INFO, 
and ArcInfo software. Basemap data for areas as large as the world and as small as a census 
block are available.  

The ArcData catalog is your complete reference for geographic data in formats compatible with 
ESRI software. With more than 150 pages of information, the ArcData catalog summarizes the 
many diverse datasets available through the ArcData Publishing Program. This document 
provides instructions for downloading or ordering the ArcData catalog. The Web Edition of the 
ArcData catalog is accessible from the ESRI Web page at http://www.esri.com/data.  

To order an ArcData catalog or some data, contact ESRI at 1-800-GIS-XPRT (1-800-447-9778). 

 
 

Through the Geography Network Web site (http://www.geographynetwork.com), you can 
access many types of geographic content, including live maps, downloadable data, and more 
advanced services. The Geography Network provides access to the latest information available 
directly from the source.  

 
 
Exercise 
 
Import and convert data to grids 
 
In this exercise, you will convert a USGS digital elevation 
model (DEM) into a grid theme. DEMs contain sample 
points of elevation. You will use the Compute Hillshade 
function to visualize the new theme. 

  

  
 
If you have not downloaded the 
exercise data for this module, you 
should download the data now. 

     
 

Step 1  
 
Start ArcView 

  
Start ArcView and load the Spatial Analyst extension.  

Note: If you are running ArcView GIS 3.1, you see a Welcome to ArcView GIS dialog. 
  



Click Cancel to close this dialog. 

If ArcView is already running, close any open projects. 

 
Step 2  

 
Open the project   

  

From the File menu, choose Open Project. Navigate to the gridsa\lesson3 directory 
and open the project l3_ex04.apr. 

Note: If you are running ArcView GIS 3.1, you see an Update l3_ex04.apr message 
box. Click No to dismiss this box. 

When the project opens, you see an empty Mt. Whitney view. 

  

 
Step 3  

 
Import a DEM to a grid  

  

From the File menu, choose Import Data Source.  

In the Import File Type dropdown list, choose USGS DEM and click OK.  

In the Import dialog, navigate to the gridsa\lesson3 directory and select the file 
whitney.dem. Click OK.  

In the Output Grid dialog, navigate to the gridsa\lesson3\work directory and name 
the new grid whitney.  

The whitney.dem file is converted to a grid and stored in the work directory.  

When prompted to add the grid as a theme to the view, click Yes. Turn on the whitney 
theme and make it active.  

 

  

 
Step 4  

 
Visualize the theme  

  
To get a better visualization of the mountains, from the Surface menu, choose 
Compute Hillshade. Click OK to accept the Hillshade settings and then turn on the 
Hillshade theme. 

  

 
Step 5  

 
Close the project  

  
Close the project without saving any changes.  

You have completed this exercise 
 

 
Summary 
 

In this lesson, you learned how ArcView Spatial Analyst stores and manages grid themes. Grids 
are stored in a workspace, each containing one info directory. Each grid is a subdirectory within 
the workspace. The grid subdirectories contain data files about the grid. The grid data structure is 
based on a transparent tile-block structure. You should use the Source Manager to copy, delete, 
and rename grid datasets. Do not use operating system commands to perform these tasks. 



Grid themes have properties including source directory, cell size, row and column, grid extent, 
type and status. Grids can be temporary or permanent. Temporary grids result from spatial 
analysis and map queries. 

Grids can be created or exported to and from a variety of data sources. Feature and image 
themes can be converted to grids. ArcView Spatial Analyst can create grids from ASCII, Binary, 
USGS DEM and USDMA DTED files. ArcView Spatial Analyst can export to ASCII or binary 
raster files. Integer grid themes can converted to polygon shapefiles. 

Sources for data include the ArcData publishing program, ArcData providers, and DataHound 

This is the Understanding the ArcView Spatial Analyst Grid Model - Lesson 3 Self test. 
 Please watch your time—you have 2 hours to complete this test.  

Use the knowledge you have gained in Understanding the ArcView Spatial Analyst Grid Model to 
answer the following questions. You will need to correctly answer 7 of the following questions to 
pass.  

Netscape Users: Do not resize this browser window. This can cause the page to reload 
and generate new questions.  

GOOD LUCK!  

 
1.  Integer grid values are stored as four-byte integers (long integers). 

True 

False 

2.  A tile is divided into squares known as blocks. 

True 

False 

3.  Both integer and floating point grids are compressed using adaptive run-length encoding. 

True 

False 

4.  Grids are stored within a workspace directory. 

True 

False 

5.  You should not use your operating system to move, copy, or delete grid sets. 

True 

False 

6.  What is the maximum number of tiles in a grid? 



999 x 999 

9,999 x 9,999 

40,000 x 40,000 cells 

4,000,000 x 4,000,000 

7.  ArcView Spatial Analyst can import grids from ASCII or binary raster files, USGS DEMs, and 
U.S. DMA DTED files. 

True 

False 

8.  ArcView Spatial Analyst can export grids to ASCII or binary raster files, USGS DEMs, and 
U.S. DMA DTED files. 

True 

False 

9.  Which of the following is never found in a grid subdirectory? 

Blk.adf 

Hdr.adf 

Prj.adf 

Dblbnd.adf 

10.  What is the maximum size for a tile in a grid? 

40,000 x 40,000 cells 

400,000 x 400,000 cells 

4,000,000 x 4,000,000 cells 

4,000,000,000 x 4,000,000,000 cells 
 

 

Calculate My Grade
 

 


